COUNSELLING COURSE UNIT REGULATIONS
School of Counselling
All students and academic staff in the School of Counselling MUST read these Regulations.
These Regulations apply to all units offered in the School of Counselling.
The College will NOT be held responsible for any disadvantage caused to students as a result of
students not reading these Regulations.

A. PHILOSOPHY
Excelsia College policies and procedures, including those outlined in this document are framed in the
context of the underlying intent to build a higher education learning community:
1.
2.
3.
4.
5.

focused on excellence;
that is identifiably and unashamedly Christian;
where creative activity and academic performance is expected, valued, and appreciated;
staffed by qualified, supportive and dedicated teaching professionals;
attended by students who are mature and respectful members of a vibrant learning
community;
6. producing graduates who contribute responsively and responsibly to their families,
communities and workplaces.

B. ACADEMIC OFFENCES
The Table below summarises the criteria and penalties for various academic offences relating to
course units within the College. Some of these offences are explained in more detail later in this
document.
Offence

Criteria

Minimum Penalty

Maximum Penalty

Bullying, harassment,
discrimination or intimidation
towards any student or staff
person

Every such case attracts a
penalty

Warning from Head of
School

Exclusion from the
College

Disrupting, disadvantaging or
demeaning the learning of
other students

Every such case attracts a
penalty

Warning from Head of
School

Exclusion from the
College

Incomplete assessments

Any missing assessment tasks Failure of the unit
or components of tasks

Failure of the unit

Lack of class and/or online
participation

Not participating fully in all
designated class and/or
online activities

Warning from Lecturer

Failure of the unit

Plagiarism

Every case of plagiarism
attracts a penalty

Downgrade of marks for
assignment (for initial
minor offence)

Exclusion from the
College

Submission of sub-standard
written work for assessment

Any written assignment not
meeting Minimum
Assignment Standards

Return of assignment to
student for resubmission

Failure of the
assignment

Wilfully damaging property of
the College or any of its staff
or students

Every case of wilful damage
attracts a penalty

Warning from Head of
School

Exclusion from the
College

C. GRADING
Student performance in a course unit is graded and notified according to the following scale. Only
letter grades are published, not numerical marks. The level and meaning of each grade is as follows:
CRICOS Code 02664K
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Final Grades
H+

High Distinction

95%+

H

High Distinction

90% - 94%

H-

High Distinction

85% - 89%

D+

Distinction

80% - 84%

D

Distinction

75% - 79%

C+

Credit

70% - 74%

C

Credit

65% - 69%

P+

Pass

60% - 64%

P

Pass

55% - 59%

P-

Pass

50% - 54%

N

Fail

Below 50% Inadequate level of achievement

S

Satisfactory

Required level of achievement in a unit assessed only on a
Pass/Fail basis

CS

Conditional Satisfactory

Required level of achievement will be reached through the
satisfactory completion of an extension unit

W

Withdrawn

Withdrawal without penalty after census date in approved
special circumstances. This grade can only be issued by the
Registrar

Outstanding level of achievement

High level of achievement

Intermediate level of achievement

Adequate level of achievement

Interim Grades (Questions about interim grades should be directed to the Lecturer)
X

Extra Work Required

Additional work must be completed successfully for a 50% P(Pass) grade to be awarded. An X grade cannot be converted to
a higher grade than a Pass grade.

E

Extension

Unit extension granted, in exceptional circumstances, for a
short time beyond the end of a semester. Any grade may be
awarded on successful completion of all required work.

I

Incomplete

Unit extension sometimes granted for a short time beyond the
end of semester, usually as part of an intervention strategy for
a student at risk. Only a 50% P- (Pass) grade may be granted on
successful completion of outstanding work.

U

Result Unavailable

An interim grade to allow for unavoidable marking delays

NC

Not Complete

An interim grade issued when a unit has not yet finished

IP

In Progress

An interim grade issued at semester-end in a year-long unit

The general standards that students must achieve to obtain various results are described in more detail
here.

D. CLASS ATTENDANCE AND PARTICIPATION
Class attendance and participation are critical for student success. As such, full attendance and
participation in all classes is a clear College expectation, and students can FAIL units on the basis of
inadequate class attendance and/or participation. Enrolment in a unit indicates the student’s
acceptance of responsibility for attending all class sessions as required, participating fully in all class
activities, and completing to an acceptable standard all in-class (and other) assessment tasks and
activities.
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In addition, absences from class may be used as evidence in cases involving unsatisfactory academic
progress and/or academic misconduct.

E. MONITORING MINIMUM ACADEMIC PROGRESS
Lecturers will oversee student progress in each unit by monitoring:
1. attendance
2. participation
3. assessment submission and/or performance.
Student failure to complete requirements in any of the areas above will result in the student being
deemed “At Risk of Failure”. Lecturers will advise relevant Heads of School about students considered
to be “At Risk”. A Head of School may recommend that a student “At Risk”:
1.
2.
3.
4.
5.

accesses tutorials, mentoring, or study skills programs
reduces their current course load
attends counselling (a free service is provided by the School of Counselling)
completes additional work for learning development
accesses other services as deemed appropriate.

Minimum academic progress is defined as passing 50% of all enrolled units in every semester. Under
Standard 10 of the National Code 2007, Excelsia College is required to systematically monitor, record,
and assess students’ course progression, and put in place strategies that identify and assist students
who are at risk of not making satisfactory course progress.
Staff will document their monitoring and “At Risk” intervention strategies to ensure students receive
the best possible assistance to achieve their study goals. Students failing to fully participate in
interventions addressing their “At Risk” status may become ineligible for assessment in the unit
concerned.
The College’s processes for monitoring student progress through the courses are set out in the
Academic Progress Monitoring and Intervention Policy and Procedure.

F. ASSESSMENT
All Excelsia College units require the completion and submission of all assessment tasks and all
components of each task. Successful completion of a unit can only be achieved if all unit assessment
requirements are satisfied, as published in the course unit outline. Each unit outline includes a
detailed description of the expectations for each assessment task. Type-written assignments are
submitted via Moodle (by 11.55pm on the due date). Unless otherwise advised by the School, all
other assignments are submitted in hard copy or on USB (for clinical videos) to the Assignment Box
located in the Library (by 5.00 pm on the due date). Written assignments will not be accepted by fax
or email, and cannot normally be given directly to lecturers. Each assignment must be accompanied
by an Assignment Title Page on which the student makes certain declarations about the work being
their own, submitted for the first time, and acknowledging sources. Normally 10% of the possible
mark for the assignment is deducted for each day the assignment is late.
Assessment tasks are graded against the published criteria, and allocated the percentage weighting
stated in the unit outline. A student will normally only be allowed to undertake assessment tasks if
he/she has satisfied class participation requirements. Once a task is assessed, students will receive
written feedback (via a marking matrix) including a preliminary grade. The grade awarded for any
assessment will be subject to a Moderation process at the end of the semester, and may be altered
accordingly.
Written assessments should conform to the Minimum Standards outlines below. Assignments not
meeting these standards are open to a range of penalties up to and including automatic failure of the
assignment.
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WRITTEN WORK
Element

Minimum Standard

Abbreviation /
Acronyms

An abbreviation is a shortened form of a work, phrase, title, etc. (e.g., PACFA is the
formed form of the Psychotherapy and Counselling Federation of Australia).
Abbreviations can be used in academic works as follows:
a) The full word, phrase title, etc. is used on the first occasion it appears in the written
work (e.g. Psychotherapy and Counselling Federation of Australia), followed by its
abbreviated form, this appearing in brackets, e.g. Psychotherapy and Counselling
Federation of Australia (PACFA).
b) Thereafter the abbreviated form can be used throughout the remainder of the
written work.

Abstract

An abstract is a brief summary of a research article, research thesis, academic/research
study. Its purpose is to provide a reader with a clear and succinct overview of the focus
and process of the article, thesis, study, etc. An abstract is often retrieved as part of a
literature search so the reader can determine whether the article, thesis, study etc. is of
interest to them.
An abstract generally includes:
a) An opening statement(s) relating to the broad area of study.
b) A statement of the purpose of the study.
c) Summary statement of the study’s participants.
d) Where appropriate, a statement of the research hypotheses/research focus.
e) Brief statement of results.
f) Brief statement of conclusions.
g) Where appropriate, a brief reference to future research/clinical direction(s).
An abstract is NOT an introduction to an essay/written work.
An abstract:
a) is indented 1 centimetre on both the left and right margin (in addition to the normal
margin), and is fully adjusted.
b) is single spaced.
c) is a minimum of 150 words and a maximum of 250 words (unless otherwise specified
differently in the assessment specifications).
d) does not include references.
Include an abstract ONLY if specified in the Assessment criteria in the Course Unit
Outline.
Where an abstract is required it is NOT included in the word count.
Justification is located under the Home tab in Word.

Annotated
Bibliography
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An annotated bibliography is a list of citations to books, articles, and other academic
works/documents. Each citation is followed by a brief (usually about 150 words)
descriptive and evaluative paragraph, known as the annotation. The purpose of the
annotation is to inform the reader of the relevance, accuracy, and quality of each cited
reference (http://guides.library.cornell.edu/annotatedbibliography). When annotating
each article included in your annotated bibliography list, addressing the following (as
applicable to each article's or chapter's content):
a) Provide the full bibliographic citation (as per the APA referencing style)
b) Indicate the background of the author(s)
c) Indicate the content or scope of the text
d) Outline the main argument
e) Indicate the intended audience
f) Identify the research methods (if applicable)
g) Identify any conclusions made by the author/s
h) Discuss the reliability of the text
i) Highlight any special features of the text that were unique or helpful (charts, graphs
etc.)
j) Discuss the relevance or usefulness of the text for your research
k) Point out in what way the text relates to themes or concepts in your course
l) State the strengths and limitations of the text
4
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m) Present your view or reaction to the text
See https://student.unsw.edu.au/annotated-bibliography for specific example of an
annotation
Appendices

An Appendix (singular) OR Appendices (plural) is an addendum/additional section to the
body of an essay/written work.
It contains supplementary information that is not essential for the completeness of the
main part of the essay/written work.
It may include: (i) Participation Information Form, (ii) Signed Consent Forms; (iii) A copy
of a survey used in a study; (iv) Additional results from the study; (v) Any further
information which may clarify, elaborate etc some aspect of the body of an essay/written
work.
An Appendix /Appendices may include in-text citation(s) and reference(s).
An Appendix /Appendices are placed AFTER the Reference List.
An Appendix/Appendices page will have a bolded heading and left-aligned. Where there
are multiple appendices they are denoted by either an alphabetical (e.g., Appendix A, B
etc.) or numerical listing (e.g., Appendix 1, 2, etc.).

Assignment /
Assessment
Title Page

Assignment /Assessment Title Page is the formal Excelsia College Cover Sheet students
must attach to all assessments. One must be uploaded on Moodle along with each
submitted assessment task. It must be completed, dated and signed.

Body of
Essay/Written
Work

The function of the body of an essay/written work is to fully develop the argument
/discussion outlined in the introduction.
The body consists of multiple paragraphs, each of which considers one major point in the
development of the overall argument/discussion (although some points may consist of a
number of sub-points, each of which will need a paragraph).
The body contains all relevant evidence, examples, detail, etc required for establishing
the validity of the arguments, the paragraphs logically ordered, progressively setting out
the author’s position in relation to the issue/area/topic, etc. under examination.

Brackets /
Parentheses
Bullet Points

Parentheses are not used in academic writing except when indicating an acronym (e.g.,
(PACFA).

Case
Formulation

A case formulation is a way of summarising diverse information about a client in a brief,
coherent manner for the purpose of better understanding and treating of the client. It is
to include the following components (unless otherwise specified in assessment task) :

Do NOT use bullet points, numbering (e.g., 1. (1.), etc.) and/or letters (e.g., a. (a), etc.)
unless specifically required or specified in the essay/written work’s guidelines.

a) a client description, including age, gender, relationship status, employment, other
relevant demographic factors (e.g., family of origin and current family configuration,
etc.) as is known;
b) a brief mental status summary, addressing appearance, attitude, behaviour, speech,
affect, mood, thought processes, thought content, perception, memory/
concentration, insight/judgement, as is known;
c) a description of the presenting problem and an accompanying diagnostic impression
based on DSM 5 (if applicable), giving reasons for decision;
d) an outline of predisposing factors (e.g., historical, developmental and/or genetic) that
contribute to the presenting problem;
e) precipitating factors (i.e., recent triggers that have contributed to the problem);
f) perpetuating factors that are maintaining the problem (e.g., any reported biological,
emotional, social, spiritual and/or physical issues, and associated thoughts, feelings
and/or other reported experiences);
g) protective factors (e.g., personal strengths, social supports, faith, etc.) that can be
deployed for the benefit of the client; and
h) any involvement of a psychologist/psychiatrist/GP or other health professional(s),
including any formal diagnosis and assessment information, as is known; and
i) potential alternate referral options, if required).
Students will be expected to differentiate between primary (i.e., crucial) and secondary
(i.e., supplementary) information in preparing the case formulation. Students may
organise their case formulation employing suitable section headings.
A clear, coherent and well-researched case formulation will:
STU-G17-CO
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a) include all relevant sections of a case formulation;
b) comply with all counselling course unit regulations relevant to the preparation and
presentation of a case formulation (provided in Moodle);
th
c) be compliant with the Beginner’s guide to the APA 6 ed. Referencing Style Manual
(provided in Moodle);
d) use ideas and argument effectively, strongly supported by reference to relevant,
contemporary peer-reviewed articles and chapters from academic texts;
e) evidence depth and breadth of research, employing a minimum of 5 per 1000 words
suitable academic references;
f) demonstrate critical reading, critical thinking, comprehension and synthesis of
relevant theoretical and clinical issues and research literature;
g) feature well-developed arguments and originality of ideas, presented in appropriate
temporal and logical order; and
h) abide by the word limit policy (no more than 10% over or under the word allowance).
Case Study
Report

A case study report summarises key information regarding the presentation and
treatment of a client. It is to include (unless otherwise specified in the assessment tasks):
a) a case formulation (as per the specified word count in course unit outline including
points (i) through to (ix) or as specified in the course unit outline);
b) potential treatment approaches and/or clinical interventions, contextualised within a
counselling modality (e.g., Person-centred Therapy, Narrative Therapy, CBT, etc.), and
an accompanying justification for said choices (as per the specified word count in
course unit outline);
c) any documented short and/or long term goals negotiated with the client (as per the
specified word count in course unit outline); and
d) current clinical hypotheses held by the counsellor, theoretically contextualised (e.g.,
attachment theory, developmental theories, systems theory, etc.) (as per the
specified word count in course unit outline).
Students will be expected to differentiate between primary (i.e., crucial) and secondary
(i.e., supplementary) information in preparing the case study report. Students may
organise their case study report employing suitable section headings.

Colon/ Semicolons

A guide to understanding the correct use of a colon and semi-colon is located at:
http://www2.le.ac.uk/offices/ld/resources/study-guides-pdfs/writing-skills-pdfs/semicolon-colon-v1%200.pdf

Colour

Do NOT use colour anywhere in the essay unless specifically required in the essay/written
work’s guidelines.

Conclusion

The function of an essay/written work's conclusion is to restate the main argument
outlined in the body of the work. It serves to remind the reader of the strength(s) of the
argument (i.e., it reiterates the most important evidence supporting the argument).
It is NOT simply a repetitive summary as this reduces the impact of the argument
developed in the work. Instead, it provides a forum for the author to persuasively and
succinctly restate the thesis, given the reader has read all the information about the topic
as provided by the author.
A conclusion may also contain a reflection on the evidence presented, or on the work's
thesis (if specified in the assessment guidelines). Questions which may be considered in a
final reflection include:
a) What is the significance of the findings?
b) What are the implications of the conclusions for this topic and for the broader field?
c) Are there any limitations to the author’s approach?
d) Are there any other factors of relevance that impact upon the topic but fell outside
the scope of the essay?
e) Are there any suggestions the author can make in terms of future research?
The conclusion should match the introduction in terms of the ideas presented and the
argument put forward.
A conclusion may spread across several connected paragraphs.
Importantly no new information or new ideas are included in the conclusion.
In-text citations do not generally appear in a conclusion.
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Content

Essays/written work must, at the very least, address:
a) the topic/question as specified in the assessment guidelines, AND
b) each part of the topic/question as specified in the assessment guidelines/ appendix.

Contractions

A contraction is a shortened form of a word or group of words, with the missing letters
usually marked by an apostrophe (e.g. , do not is contracted to don't). Contractions are
NOT used in academic writing.

Cover Page

Include a separate Cover Page/Title Page, containing:
a) Title of essay/written work
b) Student’s Name
c) Student Number (SID)
d) Lecturer’s Name
e) Unit Name and Unit Number
f) Running Header
A Cover Page is NOT the Assignment Title Page (which is also required when uploading
assessments on Moodle.

Electronic
Referencing
Tools

A number of electronic reference/bibliographic systems are available (e.g., Endnote,
Reference Manager, etc.). Students employing these electronic tools are responsible for
ensuring their presentation of the APA style conforms with the abridged version of APA
as provided in Moodle.

Endnotes

Endnotes are additional pieces of information recorded at the end of an essay/written
work. They are included when an author needs to further clarify a position/point, and/or
wants to provide the reader with further clarifying/elaborating details regarding a
point(s) the author is making.
Endnotes are located at the end of the written work (after the reference list and prior to
any appendices). In the body of the written work Endnotes are indicated by an upper
Superscript (E.g. These children face a number of challenges each day1), with the
corresponding number appearing in the Endnote section (1. These challenges include.....).
Endnotes are not used in conjunction with footnotes.
Endnotes are in Font 10 and are located under the Reference tab in Word.

Essay

A clear, coherent and well-researched essay which:
a) includes all relevant sections of an essay (e.g., title page, abstract (if required),
introduction, body of paper, conclusion, endnotes/footnotes (if required), reference
list, appendices (if required);
b) complies with all counselling course unit regulations relevant to the preparation and
presentation of an essay (provided in Moodle);
th
c) is compliant with the Beginner’s guide to the APA 6 ed. Referencing Style Manual,
(provided in Moodle), including full in-text citation and inclusion of a reference list;
d) uses ideas and argument effectively, demonstrating critical reading and critical
thought (i.e., arguments are well-developed and presented), and comprehension and
synthesis of ideas;
e) evidences appropriate use of relevant literature (i.e., seminal works and/or
contemporary peer-reviewed articles, chapters from academic works, books, etc.)
demonstrating breadth and depth of research, employing at least the minimum
number of references specified a given assessment task;
f) complies with the word limits as set out in the Assessment Policy (no more than 10%
over or under the word allowance).

Font

Use 12pt Times New Roman or Arial font. Font is located under the Home tab in Word.

Footnotes

Footnotes are additional pieces of information printed at the bottom of a page, included
when an author needs to further clarify a position/point, and/or provide further
clarifying/elaborating details.
They are located at the bottom of the relevant page. In the body of the written work they
are indicated by an upper Superscript (e.g., These children face a number of challenges
1
each day ), with the corresponding number appearing in the Footnote section coupled
with elaborating information (e.g., 1. These challenges include.....).
Footnotes are not used in conjunction with endnotes.
Footnotes are in Font 10 and are located under the Reference tab in Word.
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Group
Management
Strategies

When facilitating a group activity students are expected to:
a) create an atmosphere of safety, acceptance, personal presence and competence;
b) encourage appropriate risk-taking and self-disclosure;
c) maintain goals and time allocation for the group;
d) control group norms;
e) identify and carefully manage roles that group members adopt;
f) confront any arising personal issues related to group processes and manage these
without affecting the group;
g) ensure they make an equitable contribution to the group assessment task, as agreed
upon by the whole group; and
h) attend all relevant agreed-upon group meetings.

Group Program

A group program is to consist of the following components (unless otherwise specified in
the assessment description):
a) A program title page.
b) A program rationale, including the appropriateness of its use for both (a) the selected
mental health or relational issue and (b) the specific target group, not exceeding a
maximum of one (1) page.
c) The program aims and proposed learning outcomes for the program, not exceeding
half (½) a page;
d) An overview outline of the entire program (e.g., a Table of Program Content, not
exceeding a maximum of one (1) page).
e) Identification, screening and selection of participants, including contra-indications for
participant inclusion; not exceeding a maximum of half (½) a page.
f) A brief summary of the focus of each session, not exceeding a maximum of two (2)
pages.
g) Two (2) complete sessions, outlining (a) session format; (b) time allocation per
session task; (c) any activities linked to the session; (d) any resources to be utilised in
the delivery of each session (e.g., worksheets, etc.). Where resources are too large to
include in the folder a picture of the resource may be included in its place).
h) If appropriate, post-participation assessment, follow-up, de-briefing etc, not
exceeding a maximum of one (1) page.
i) A reference list of academic works which have informed the program’s development
(no exceeding nominated number of references).

Group Program
Review

A group program review should:
a) provide a brief and concise summary of the two (or more) programs, including the
core aims of each program, the duration of the program, selection of participants,
contra-indications for participant inclusion, training required to facilitate program,
and suitability for use by a counsellor;
b) nominate the most appropriate settings (e.g., church, school, etc.) in which to run the
programs, including a brief justification for choice of setting;
c) outline the strengths and weaknesses of each programs, indicating to what extend
their efficacy has been established; and
d) propose possible changes to the programs which could increase their effectiveness
with respect to participant outcomes.

Indenting of
paragraphs

Each paragraph’s topic sentence (i.e., the opening sentence) is indented 1 centimetre.
Indenting is located under the Page Layout tab.

In-text citations

APA Referencing Style (6 Edition) requires that ALL sources which inform an author’s
thoughts and arguments and his/her subsequent body of writing must to be cited WITHIN
the body of an essay/written work.
APA uses the author-date method of citation (e.g., Smith, 2014 – single author reference;
or Smith, 2014, p.1 – single author reference direct quote).
th
Please see the APA Referencing Guide (6 Edition) provided by the School of Counselling
(see Moodle) for details related to in-text citation rules for different sources (e.g. books,
chapter, web-pages, multiple authors, etc.).

Introduction

The Introduction serves as a 'map' of the essay, outlining the main argument and points
which the author will subsequently develop in the body of the essay/written work.
Generally an Introduction:
a) begins with an orientation (in the form of a brief general statement) that leads the
reader into the topic area, showing how the specific topic relates to bigger/broader
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issues in the discipline field;
b) identifies the topic and purpose of the essay/written work;
c) includes a thesis statement, which is the author’s concise response to the essay
question; and
d) includes a summary outline of the argument to be presented in the essay/written
work.
In general the introduction acts like a funnel, moving from the general area of focus to
the specific area/agenda/focus of the essay/written work.
In-text citation(s) may appear in an introduction.
Justification

The body of the essay/written work is left-aligned/left-justified (unless other specified).
Justification is located under the Home tab in Word.

Line Spacing

Double spaced (2 lines) within paragraphs.
Line spacing is located under the Home tab in Word.
6pts before and after each paragraph.
Spacing is located under the Page Layout tab.

Literature
Review

A literature review is an evaluative report (i.e., a critical analysis) of information found in
the research literature related to a particular field. The review should describe,
summarise, compare, evaluate and clarify prior research studies, other reviews and
theoretical academic works related to a particular field. A literature review is to consist
of the following (unless otherwise specified in the assessment task):
a) Title Page
b) Abstract (200 words)
c) Running Header (limit of 50 characters)
d) Page numbers (In Footer)
e) Introduction: Overall presentation of topic/thesis statement/research question
f) Body: Multiple paragraphs (See paragraph description) addressing the topic/issue,
concepts/ideas etc. presented in logical and temporal ordering, fully referenced (intext citations)
g) Implications for further research, further clinical care etc
h) Conclusion
i) Reference List.
Multiple examples of how to do a literature review can be located via Google.

Logs

Students are required to provide written evidence of completion of the counselling
sessions, by submitting a completed and signed logbook, using the provided log
template. All dates, names and signatures must be present for a log to be deemed
complete.

Margins

Use page margins that are at least two centimetres all round (i.e., left, right, top and
bottom). Page margins are located under Page Layout in Word.

Original Work

Essays/written works must have been prepared ONLY by the student.
It must not reuse/include work previously submitted for another essay/written work,
except where such re-use/inclusion is specifically permitted, as specified in the
assessment description.
It must not be edited or corrected by a third party (ghost-writing).
It may be reviewed by a lecturer as part of the learning process.

Numerals

Numbers, when used in an essay/written work, need to conform to the rules specified in
the APA Numerical Guide (2014) (see Moodle).

Page Numbers

Page numbers are to be positioned at the bottom of the page.
They are right-aligned.
Page numbers are located under the Insert tab in Word.

Paragraph
construction
and ordering

Each paragraph must include:
a) A topic sentence which opens the paragraph; its function to set the theme/tone/
message of the specific paragraph.
b) A concluding sentence which closes the paragraph, its function to draw together the
threads presented in the paragraph.
c) Additional sentences that may (i) provide clarifying, supporting, elaborating,
contracting, and/or comparative information and details; (ii) provide statistics; (iii)

STU-G17-CO

9

Issue 4, January 2016

include relevant quotes, and (iv) include relevant in-text citations.
d) Generally between 4-6 sentences focused on a single or related themes, these are
coherently integrated.
IMPORTANTLY, a paragraph DOES NOT consist of one or two sentences, nor does it
extend to a whole page or longer.
Paragraphs may be presented according to:
a) Time (e.g. Historical) / Temporality (past, present, future).
b) Theme, related concepts, etc.
Connected paragraphs are characterised by threads that relate to the topic/question
being addressed in the essay/written work, these logically ordered.
Percentages

In APA Style, percentage(s) is presented as follows:
a) Use the percent symbol after any number expressed as a numeral. For example: 12%.
b) Use the word "percent" after any number expressed as a word. For example: five
percent.
c) Use the word "percent" after any number that begins a sentence, title or text
heading. For example: Forty-eight percent of the sample showed an increase.
d) Use the percent symbol in tables and figures even if the symbol follows a number
smaller than 10.
e) Use the word "percentage" when you do not provide an exact number. For example:
The student determined the percentage of rats that ate the food in the control
condition.

Person

Always write in the 3 person (e.g., the author/the writer) and not 1 person (e.g., ‘I’) –
unless otherwise specified in the specific assessment task. It is important to stay in the
same person throughout the written work (i.e., not to shift from 3rd to 1st person).

Psychoeducational
handout

A psycho-educational handout is a one page (A4 double-sided page) document suitable
for distribution to clients diagnosed with the particular disorder, addressing: (i) the
nature and causes of the disorder, (ii) possible approaches to treatment of the disorder,
(iii) strategies which clients can employ to support their ongoing therapy, and (iv) any
additional resources and websites relevant to the disorder.

Reference
List/Page

In APA Referencing Style (6 Edition) the Reference List/Page is located on a separate
page at the conclusion of an essay/written work (placed prior to any appendices).
It lists ONLY the information sources that have been cited directly within the body of the
work.
The heading References is BOLDED and left-aligned at the top of the page.
Always include a Reference List, unless specified otherwise in the assignment guidelines
(see CUO).
Each reference must be:
a) Double spaced within the individual reference.
b) Double spaced between each reference.
c) Second and subsequent lines of the reference are indented by 1cm.
If referencing a book, in APA the reference includes: (i) Author(s), (ii) Date of publication,
(iii) Title (in italics), (iv) Location of Publication, and (v) Publisher(s)’s name.
If referencing a chapter in a book, in APA the reference includes: (i) Author(s) of the
individual chapter, (ii) Date of publication, (iii) Chapter Title (in italics), (iv) Author(s) of
the Book, (v) Name of Book, (vi) Page numbers of the chapter, (vii) Location of
Publication, and (vii) Publisher(s)’ name.
If referencing an article, in APA the reference includes: (i) Author(s); (ii) Date of
publication; (iii) Title of article, (iv) Title of Journal (in italics), (v) Journal Volume (in
italics), (vi) Journal Issue, (vii) Range of Pages, and (viii) the Digital Object Identifier (DOI)
which is a character string used to uniquely identify an object such as an electronic
document (if available).
th
Please see APA Referencing Guide (6 Edition) provided by the School of Counselling for
further detailed examples of different source types.

References
Minimum
Number

Unless specifically stated otherwise, postgraduate essays require that at least five (5)
academic or professional references (e.g., journals, papers, academic texts, professional
papers) must be cited per 1000 words of text.
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The criteria for each assessment will specify a minimum number of articles required for
the assessment.
Referencing
Style

The Excelsia College School of Counselling stipulates the use of the APA Referencing
th
System for the essay/written works (e.g. APA Referencing Guide [6 ed.]). This is
provided to students via Moodle.

Research Paper

A research paper is the culmination and final product of an involved process of research,
critical thinking, source evaluation, organization, and composition
(https://owl.english.purdue.edu/owl/resource/658/02/). It includes the following
sections:
a) a title page, including a running header;
b) a 200-word abstract, notable for its completeness;
c) an introduction, notable for the integration of material within appropriate
subsections (i.e., under appropriate headings), with an overall funnelling to a clear
and well supported research hypothesis/research question, and characterised by
cogency of argument;
d) research methodology, notable for the inclusion of all relevant method sections;
e) research results/findings, notable for appropriate inclusion of relevant summarised
data;
f) discussion, notable for appropriate evaluation of research aims/hypotheses,
accompanying theoretical, clinical and/or methodological explanations and justified
implications, and appropriate indication as to the significance of the research paper’s
contribution to the theoretical and/or clinical area of focus;
g) reference list, notable for its depth and breadth of included relevant peer-reviewed
literature;
h) appendices, notable for their appropriateness of inclusion and their link to the body
of the research paper.
The research paper must demonstrate:
a) appropriate writing style, notable for its clarity;
b) appropriate academic formatting, in accordance with the counselling course unit
th
regulations and the Beginner’s guide to the APA 6 ed. referencing style manual
(provided in Moodle), including full in-text citation;
c) a highly readable style; and
d) overall internal coherence.

Running Header

A Running Header is an abbreviation (i.e., short form) of the title of an essay/written
work (e.g. if the Full Title was ‘The development of spirituality in adolescence’ the Running
Header might be ‘Spirituality in Adolescence’).
It is in Font 10, right-aligned in the top right-hand corner of the page (set within the
Header).
Header is located under the Insert tab in Word.

Sentence

A sentence has a subject and a verb and must contain a complete thought.

Spelling

Minimum academic standard is less than 5 spelling errors per 1000 written words.

Syntax/
Grammar
Tense

Minimum academic standard is less than 5 syntactical/grammatical errors per 1000
written words.
Tense expresses distinctions of time or duration of the action/state being discussed/
described:
a) Past tense refers to actions/events etc that occurred in the past, e.g., ‘I walked along
the beach’.
b) Present tense refers to actions/events etc that are occurring in the present, e.g., ‘I am
walking along the beach’.
c) Future tense refers to actions/events etc that will occur in the future, e.g., ‘I will walk
along the beach’.

Use the same tense throughout the written work.
Voice

STU-G17-CO

Voice refers to the relationship between the subject and the verb in a sentence.
a) Active voice in a sentence is when the subject is doing the acting, e.g., “Kevin hit the
ball”, i.e., Kevin (the subject of the sentence) acts in relation to the ball.
b) Passive voice in a sentence is when the subject of the sentence is acted upon by
11
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some other agent or by something unnamed, e.g. ’The ball was hit by Kevin’.
Always use Active voice (unless otherwise specified).
Use passive voice ONLY if specified in the assessment criteria.
Word Count

Included in the Word Count are:
a) All in-text citations.
b) All headings and words in the body of the essay/written work.
Excluded from the word count are:
a) Title page.
b) Headers and Footers.
c) Abstract.
d) Footnotes.
e) Reference List.
f) Endnotes.

Word Limit

The word count of an essay/written work must be within 10% (over or under) of the
stated assessment word limit, as per the assessment guidelines.
a) Where the work exceeds the 10% word limit, the additional content will not be read
nor considered in the grade allocation and the student will lose 10% of their final
grade.
b) Where the work is significantly less than the word limit (more than 10% under) the
paper is likely to inadequately address the assessment guidelines under consideration
and, consequently, will be significantly marked down.

Written Form

All essays/written work must be type-written.
Hand-written essays are NOT acceptable, unless specifically permitted, as per the
assessment criteria.

ORAL PRESENTATIONS
Element
Content

STU-G17-CO

Minimum Standard
Unless otherwise specified, a School of Counselling in-class oral presentation consists of
the following:
a) a presentation overview;
b) a presentation rationale (i.e., a clear statement of the presentation’s purpose, and
the problem/issue(s) to be addressed during the presentation);
c) accompanying student learning outcomes;
d) a well-structured and coherent body of relevant content, presented in a unified and
coherent manner;
e) appropriate conclusions, consistent with the presented ideas;
f) temporal order and logical flow of ideas and arguments throughout the presentation;
g) oral delivery which is clear, well paced, with appropriate vocal intonations, etc.;
h) appropriate use of relevant literature (employing the minimum of references
specified in the assessment task criteria (e.g., seminal works and/or contemporary
peer-reviewed articles, chapters from academic works, books, etc.) demonstrating
breadth and depth of research;
i) an accompanying set of quality PowerPoint slides (or similar) using an easily readable
font (e.g. Arial, Cambria, Calibri, New Times Roman, etc. ) no less than font size 18);
j) a double-sided A4 handout which includes a summary of the presentation’s key
points and a short reference list of the most relevant articles that informed the
presentation;
k) evidence of active engagement with, and synthesisation of relevant peer-reviewed
articles and chapters from relevant academic texts;
l) a minimum of three appropriate and thought-provoking questions employed to
facilitate an engaging and well managed class discussion; and
m) compliance with the stipulated presentation time limit, or a relevant penalty will
apply (10% mark reduction).
Students are also required to employ appropriate supporting images (as is relevant to
topic/issue, etc.) and include a Reference List on the concluding slide. Content on each
slide is to be referenced at the bottom of the relevant slide.
12
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Delivery

A confident oral delivery is required, one that:
a) is moderately paced;
b) involves limited reference to supporting notes;
c) demonstrates understanding of the topic/issue etc under consideration;
d) provides a synthesisation of relevant research literature related to the topic/issue, etc.

Timing

All presentations will be doubled timed, with time monitored by:
a) the lecturer, AND
b) one volunteer student.
When the presentation is a group presentation, time spent speaking should be equally
shared between group members.
Ideally a stop watch (e.g., on a phone) will be employed, with the lecturer indicating the
commencement time and the conclusion time (confirmed by the student timers).
All work presented after the end of the allocated presentation time will not be graded.

G. EXTENSIONS
Any application for an assignment/assessment extensions MUST be made BEFORE the published
assessment due date. Lecturers will not (without penalty) accept late work for which a prior extension
has not been obtained. In general extensions to submission deadlines are only granted for
circumstances for which the student is not responsible, and which prevent the student from
completing an assessment task by the due date. Such circumstances may be summarised under the
following headings:
1. medical (with a Medical Certificate as supporting evidence);
2. bereavement (supported by funeral or similar notice);
3. official (evidence of studies being significantly interrupted by court, jury duty, immigration
requirements, or similar official business over the timing of which the student has no control);
4. unforeseen circumstances of a serious nature (beyond a student’s control, for which the
student is not responsible, and which will prevent the student from timely submission of an
assessment task).
Situations that do NOT constitute acceptable reasons for an extension include, but are not limited to:
1. computer difficulties (student must regularly Save, Print, Back-up ALL their work).
2. workload pressures involving the current or other subjects.
3. employment or study-related interviews or appointments.
4. employment-related workload pressures or difficulties.
5. absence from home (except in emergencies relating to the permissible reasons listed above).
6. domestic tensions or issues, including issues involving pets.
7. medical appointments other than in the case of serious illness or emergency.
If an extension is required, students complete the Application for Extension, present it to the relevant
Lecturer for endorsement, and then to the Head for approval. The student must keep a copy of the
approved form and provide a copy to the Lecturer. The original approved form must be attached to
the submitted assignment and uploaded on Moodle in order to ensure that no penalty is applied for
lateness.
Students should not expect an extension for more than 10 working days. No ‘blanket’ (group-wide,
class-wide, or subject-wide) extensions will be granted without the permission of the Academic
Director. It is unusual for extensions to be granted for the final assessment task in any semester unless
the marking and moderation deadlines can still be met.

H. ACADEMIC INTEGRITY
The College regards academic misconduct as a very serious matter and will impose strict penalties
when it is found to have occurred. Academic misconduct includes, but is not limited to: plagiarism,
cheating, collusion, fraud, improper behaviour, misrepresentation, and unethical behaviour.
STU-G17-CO
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For further details, please refer to the College’s Academic Integrity Policy and Procedure. All students
must read this document to ensure they understand the College’s academic integrity requirements.
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